
AstroPlanner v1.5.2 
Ilanga Software 
 
Sometimes it pays to take a second look. 
 
Have y’all seen my laptop lately? If you’ve had a peek over my shoulder from the 
seat next to me on an airplane (I saw you, you li’l dickens), you’re probably 
thinkin’, “Gull-dernit, that silly old Uncle Rod has more astronomy software than 
humans should be allowed to have.” Which is mostly true, I guess. In my role as 
astronomy pundit, I get asked to take a look at a lot of stuff; everything from the 
latest TheSky to little utilities designed to help you polar align that bad, ol’ GEM. I 
don’t mind saying that I’ve got all the biggies living on my sorely laden hard drive. 
 
What you’re probably wondering, though, is, “How much of that stuff does he 
actually use?” Not much, I’ll admit. Excluding imaging software, I find myself 
really using, day-to-day using, two packages. One of these is a planetarium, 
something that will give me immediate visual feedback about the way the sky 
looks right now or will look tonight or next week. Click an icon, the sky appears 
on my screen, and I can decide if Orion’s up yet without puttin’ my thinkin’ cap 
on. 
 
I said “two packages.” Yep. The other type of program I use is a “planner.” You 
know, one of those mega-database jobs that help you plan observing sessions, 
draw finder charts, send a scope on gotos, check the weather, and make your 
lunch. I’m kidding about the lunch, but planners have come a long way since the 
days when they were thinly disguised Access databases and nothing more. I’ve 
found these programs really enhance my observing productivity. Let’s face it, 
without lists of objects to look at you’re going to be lost among the stars, real or 
virtual. Just because a program draws a pretty sky on your screen doesn’t mean 
you’ll know which objects in that pretty sky you’ll want to observe.  
 
Planners help you decide which objects you want to see, and furnish you with 
sorted lists of these objects visible at the time of your viewing session.  I’d been 
using two planners almost interchangeably for several years, Steve Tuma’s 
Deepsky and Greg Crinklaw’s Skytools 2, both fine programs I’d recommend to 
anybody. These apps are good enough, in fact, that I didn’t think there was room 
for a third entry, and was surprised when I got an email from a nice gentleman 
named Paul Rodman, asking if I’d take a look at his planner, AstroPlanner. 
 
In due course, I received an AstroPlanner (AP) CD from Paul (Ilanga Software) 
and had it installed on my then current 566mhz Win98 machine. What did I think? 
Well, to be kind, AstroPlanner seemed a work in progress. The program was, for 
example, without an installation routine of any kind, so I had to do most of the 
work myself when it came to getting the thing set up on a hard drive, copying files 
and making directories. Copying files may seem like a simple task to y’all, but, 



believe me, it’s something that can be a challenge for the resolutely computer 
illiterate—like your Silly Old Uncle.  
 
Once installed AP was, well, interesting. The user interface was nicely 
designed—the various program modules resided on well thought-out tabs, and 
there were some nice touches, especially for Meade owners, like an update of 
Jim Burrows' famous BestPair program to help Autostar users select good 
alignment stars.  
 
Alas, the bad tended to outweigh the good. Paul’s initial reason for doing 
AstroPlanner was to provide Apple Macintosh users with a planning program of 
their own, and the Apple version was nice, but the Windows version seemed an 
afterthought, being affected by a serious limitation. Due to a “resources” issue, 
AP would not run very well at all under Windows 98, which dampened my 
enthusiasm. Hell, just trying to print would often bring a crash. It became obvious 
the program needed Windows 2000 or NT, and it was at that point that I lost 
interest. Me upgrade to another Windows yet again? Uh-uh!  
 
And yet…and yet… 
 
One thing I noticed right off the bat was that Paul had accumulated a 
Yahoogroup full of enthusiastic users in a short period of time. They saw plenty 
of potential in the program, and, actually, I guess I did too. It had a certain 
something, some ineffable look and feel that I found attractive. If only it had 
worked a little better on my computer. I soldiered on with Deepsky and Skytools. 
Mr. Rodman’s little program stuck in my mind, though, and when I next heard 
from him a couple of years down the line, I had not forgotten AstroPlanner.  
 
What was new with AP? Apparently it had come a long way. Paul rattled off a 
long, long list of features, and promised me the program would work very well on 
my new XP laptop. He wondered if I might take a second look. Heck, what’s one 
more astro-app, bursting hard drive or no? I said “yes,” both out of curiosity to 
see if this promising program had really gotten off the ground, and because I was 
attracted by a list of features than included online download and caching of DSS 
images, telescope control for just about anything, and impressively large catalog 
resources (over 100 catalogs; everything from the good, old NGC to stuff like the 
Galactic Dust Cloud catalog).  
 
A very partial list of AstroPlanner’s features includes: 
 

- Cross-platform operation. AstroPlanner is available for both Windows PCs 
and the Apple Macintosh “classic” and OSX machines. 

- Reads geographic coordinates from a GPS unit, a Meade Telescope, or 
from Google Earth. 

- Choose your equipment lineup from an extensive list of telescopes and 
binoculars or setup your particular equipment manually. 



- Create Observing plans/lists to suit you, your site, and your equipment. 
- Field of view charting with many options and capabilities. 
- Extensive support for goto telescopes. 
- Incorporates Best Pair II to assist in goto telescope alignment star 

selection. 
- All-sky charts available with a mouse click. 
- User-defined data fields can be added to plans. 
- Extensive catalog search facilities. 
- Over 100 catalogs containing over 1,000,000 objects. 
- UCAC and USNO A2.0 catalogs (optional). 
- USNO B1.0 on-line access. 
- Flexible search capabilities. 
- An extensive library of user-contributed plans is available online through 

the program interface. This includes lists containing all the objects in 
Burnham’s Celestial Handbook and the Night Sky Observer’s Guide. 

- AAVSO finder and constellation charts, observation data, and observation 
planner. 

- Solar system objects including minor planets & asteroids can be plotted on 
charts and added to plans. 

- Import facilities for data on comets and minor planets. 
- PDA support for Astromist, Planetarium for Palm, and PalmDSC. 

 
To say the least, I was convinced the program deserved another look, and, when 
I received the new CD, I set about getting it up and running on my PC. The Good 
Thing here is that the installation process for the program has long-since been 
automated. Put the CD in the drive, and away you go. I didn’t try a Mac 
installation, but I’m told the process is just as easy there. Something to think 
about before you go installing this program on your PC, though, is that while 
much has been updated, one thing that has not changed is the way AP works (or 
doesn’t) under Windows 98. Yes, most folks have probably long-since upgraded 
to XP, but some of us still tend to use older machines as observatory computers. 
If you want to use AP, you need Win2000/NT or XP (or a Mac). Period. 
 
With the installation complete, as with any astronomy program, you are only 
halfway there. Before using AstroPlanner, you must input your equipment and 
information about your geographic location.  You do this in two places. The first 
place is “Resources,” found under the Edit menu (folks, I’m talking only about the 
Windows version in this review). Here’s where you tell the program where you’re 
located, what kind of telescope you use, and which eyepieces and accessories 
you own. It’s remarkably easy to get all this data entered—as long as you 
remember the central AstroPlanner interface paradigm: click a “+” button 
onscreen to add something; click an onscreen “-“ to delete something. 
Remember that and, you’ll do OK. Don’t go typing and clicking randomly and 
aimlessly as your Old Uncle is wont to do. Without first telling the program to add 
a new site with “+,” you won’t get anywhere other than Frustrationsville. 
 



 
 
Most of the site setup “questions” are self-explanatory, and include the usual 
items like latitude and longitude, DST status, and other site peculiar information 
and choices. One slight hang-up I had was that I found that for a site’s time to 
show up correctly in the program, I had to set the “time offset” to the value by 
which the site’s time would be different from the computer’s time. Since my 
computer is “on” Central Time, I had to set the offset selection to “1” for a site on 
Eastern Time. I’d a-thought setting the site’s time zone (in the “offset from GMT” 
field) would have done that, but no-sir buddy.  
 
Maybe now is a good time to talk about the AP help system. It doesn’t have one 
per se. You do have an online (and on hard drive) manual that’s pretty good, but 
it’s still not as detailed, even at over 300 .pdf pages, as it could be for such a 
complex and capable application. I read the information in this manual 
concerning clock offset, for example, and still came away scratching my head. I 
just played around until the time on the program display was correct for the site. 
 
Once you’ve got your location or locations registered, it’s time to tell AP the 
specific scopes and eyepieces you’ve got in your equipment inventory. It will use 
this data for computing field sizes in its charting module, in assisting you in filling-
in your log entries, and in determining object visibility for a particular 
scope/eyepiece combo. 
 



I found it significantly easier to set up eyepieces and scopes with AP than with 
TheSky 6. In part, this was because of the long and constantly updated lists of 
scopes and oculars in AstroPlanner. The program has the most extensive list of 
eyepieces I’ve seen. I was amazed, for example, to find my beloved WO 
Uwans—not yet a household word—there. In addition to scopes and eyepieces, 
you’ll also be allowed to tell AP about your inventory of filters—OIIIs, UHCs, etc. 
– and what AP calls “visual aids,” barlows and focal reducers. 
 
When you’re done in Resources, “Preferences” is next on your agenda. This item 
is the last entry under the Edit menu. One thing Preferences does is allow you to 
set, well, your preferences as far as program appearance and function go. At this 
early stage of the game, you may want to just leave these settings at their 
defaults. You’ll need to use AP for a while before you start monkeying around 
with fine-tuning. Anyhoo, I think you’ll find the program looks and acts pretty 
“right” as shipped. 
 

 
 
One other thing you’ll find under a Preferences tab (AP’s Windows version is BIG 
on tabbed menus, which, in my opinion is a good thing), is a place to tell the 
identify your goto telescope. These days, most programs use the ASCOM 
application for goto scope interfacing, AP, however, has its own built-in drivers, 
so there are no additional “external” programs to load or mess with. The trade off, 
of course, is that when new scopes or features come out, you have to rely on 



Ilanga to update the drivers. ASCOM releases tend to come very quickly on the 
heels of new scope and new scope firmware introductions. 
 
While you won’t use an external program for scope interfacing, that doesn’t mean 
AP can’t interact with external programs. Via the “External” tab, you can, for 
example, tell AstroPlanner to work with Cartes du Ciel, the famous shareware 
planetarium program. With CdC enabled, clicking on AP’s Field of View tab will 
automatically bring up Cartes with its display centered on the same spot as AP’s 
Field of View. Using CdC with AP gives the program more robust charting 
capabilities than those contained in its own charting module (which we’ll discuss 
shortly).   
 
After you’ve finished with all this configuratin’, you can actually start using the 
program. You’ll do that by developing observing plans which are displayed on the 
program’s main screen, the one found under the “Observing” tab. How do you 
develop a plan? You may not have to. Plans, lists of objects, can be downloaded 
from the AP website via “User-Contributed Plans” under the File menu (assuming 
you have an Internet connection). Once a downloaded plan is saved on your 
hard drive, it is opened with, surprise, “Open,” which is also found under the file 
menu. 
 
Let’s say none of the User Plans in the AP library suit your fancy, though. Maybe 
your idea of the “best” spring DSOs differs from that of Robert Burnham or Scotty 
Houston. If so, it’s very easy to put your own list together using the search and 
selection tools found under AP’s “Planning” tab, the spot where you find and 
choose objects for inclusion in your list. Or, if, like me, you’re lazy, you can 
quickly develop a list by using the program’s Plan Creation Wizard.  
 
Choose this option from under the File menu and you’ll be presented with a 
dialog box that will allow you to set the criteria the program will use for plucking 
candidate objects from its enormous array of databases. You’re allowed to select 
constellations, catalogs, object difficulty (based on the aperture of the scope you 
have selected), object types, and numbers of objects per object type. Once the 
program has a list displayed, you can go through and select only the objects you 
like, or you can choose ‘em all. Selected objects will appear as a list in the 
Observing tab and will comprise an Observing Plan you’ll name and save. 
 
Don’t like wizards? Know exactly which objects you want in your plan? It’s easy 
to retrieve these objects yourself starting from the main Planning tab. When you 
want to add an object, click “+,” just like you did when you were adding eyepieces 
and telescopes. Next, enter something in the field above the “Lookup ID” button 
in the lower left-hand area of the screen. Something? Yeah. You can enter NGC 
7293. Or you can enter NGC7293. Or you can enter “Helix.” You can even just 
enter “7293” if you want (but be aware that if you’ve got more than the NGC 
catalog selected, you’ll probably get a LOT of “hits” that way). AP is the most 
forgiving astronomy program I’ve seen when it comes to entering search 



parameters. Many similar programs will return zero results if you, for example, 
enter NGC7293 instead of the NGC 7293 the software expects.  
 

 
 
When you hit the “Lookup” button, another window will pop up, and you’ll be 
asked to choose the catalogs you’d like to search. The fewer catalogs, the 
quicker the search, natch. When the searching is done, you’ll next see a window 
that lists your “hits.” Select the object you had in mind from this list, click the “Add 
Selected” button, and your choice will appear on the list on the main Planning 
tab. When you’re all done, you can click the Observing tab and see your objects 
in a neat list ready for formatting or whatever else you want to do with them. 
 
On the observing tab, the first thing you want to do is save your new Plan (via 
“Save” in the File menu). The next thing you’ll probably want to do is impose 
some kind of order on this list by sorting the objects. That’s easily done by 
clicking column headers. Want to sort the objects by constellation? Click the 
“Constellation” header at the top of that column. Want to reverse the sort order? 
Click again. 
 
Chances are, you won’t like the horizontal arrangement of columns. If you’re like 
me, you think “Size” is more important than “RA” and “Dec,” for example, and 
want that column to come right after “Object ID.” With AP you can straighten 
things out. Just go to the edit menu, to Edit/List columns. Then, drag and drop 
“Size” into the place in the order of columns where you think it should go. This 



column-arrangement capability, one of the nicest features of the program, one 
that’s sorely lacking in competing packages, is saved with your plan.  
 

 
 
What else do you do in the Observing Tab? Just about everything. This is your 
home base, and displays information about current conditions, object status, and 
telescope position. The controls here allow you to send your goto telescope to 
objects and display a chart of the field it lands on. You can download object 
images here. You can even check sky conditions.   
 
Toward the bottom of the screen you’ll find some helpful graphics that show the 
selected object’s elevation plotted against time for the current evening in one 
pane and for the months of the year in the other. The Moon and Sun are also 
shown in these diagrams, making it easy to see when your target will be high in a 
dark sky. To the right of these two pictures there’s a pair of compass-like 
indicator needles that show “which direction” and “how high” for the current 
object. 
 
There’s a lot of functionality packed into this attractively designed screen, but 
some of its most interesting capabilities involve the Internet. Worried about the 
weather? Click Clear Sky Clocks in the “Observations” menu and, assuming you 
have a live Internet feed, you’ll be rewarded with a CSC for the currently selected 
site (pull downs at the top of the program screen allow you to select site, scope, 
and observer). Wondering whether the object in the field of your eyepiece is 



really the one you’re after? Right-click on the object in question and you’ll be 
given the opportunity to download a Digitized Sky Survey image. Not only that, 
these retrieved images are cached on your hard drive for future use, and can be 
displayed for a selected object any time you choose. 
 
I found this image retrieval feature just a godsend last fall at the Chiefland Star 
Party. I was doing dimmish little galaxies in the Fornax cluster, and being able to 
look at their pictures really helped me see them in the eyepiece. Yes, unlike most 
star parties, Chiefland has wireless Internet on the field, but you can have the 
program download batches of pictures and cache them ahead of time before you 
leave for the star party. 
 

 
 
What else do you do in Observing? As above, you can send your goto scope to 
list objects, which works incredibly well with my Meade and Celestron CATs. 
Select an object in your plan. Click the “Slew to Object” button on the main 
screen. Telescope goes there. That’s all there is to it. You can also push a button 
and display a chart of the scope’s current field of view. If your telescope supports 
it, you can even sync on the object without fussing with your hand controller. 
 
You’ve selected an object, sent the scope there, verified its identity with the help 
of the DSS, and done a lengthy observation. Don’t you want to record what 
you’ve seen for posterity? Yeah, I can hear you grumbling about that. Look, when 
you’re ready to make a log entry, you don’t even have to leave the Observing 



tab. Just hit the “+” found in the lower part of the screen, just below the little 
“Observations” window. You can then type in the “Observation Notes” space to 
your right, select the equipment used in the observation via pull-downs, and give 
your object a “rating.” AstroPlanner’s  logging system is something I don’t hear 
too many people talking about, but in my opinion it’s one of the best features of 
the program. Like most of you, I find logging a pain, and wouldn’t do it if I had to 
go to any trouble at all to do so. Logging is so easy with AP, however, that I 
actually like making entries. 
 
One thing to keep in mind as you’re working in the Observing tab is that you’re 
normally working in real time. If you want the program  to use a specific date and 
time—for an evening at next week’s star party, for example--you must go to 
“fixed date” operation via a button at the top right of the screen. Poke it, and 
you’ll be confronted with a window that lets you choose the date and time of 
interest. Having date/time correct is important, since it affects not just the Moon 
phase and rise/set times displayed on the Observing tab’s screen (nice), and the 
object elevation/time graphics, but also a rather important and valuable facility.  
 
You can instruct the program to highlight list objects that are currently visible. 
This is a real time-saver in the field. You don’t have to look at rise-set times or 
squint up at the sky. One glance at your list shows you, via highlighted entries 
(you can select the highlighting style in Preferences), WHAT’S UP. You can set 
the highlighting to show other things, too, including “not visible,” “observed,” “not 
observed,” etc., but I find “visible” most valuable. 
 
Two tabs down; two to go. The next one over from “Observing” is “Field of View.” 
And that is just that. While AstroPlanner’s  chart drawing system is capable of 
showing swatches of sky up to 60 degrees in size, drawing constellation lines, 
and doing most of the things other charting engines do, it’s really most suited to 
doing eyepiece-sized “finder charts.” 
 
There are lots of catalogs and options available in this tab, including the ability to 
plot the stars from the Hubble GSC, Tycho II, and even the USNO B cat (if 
you’ve got the data disks), but AP’s somewhat simplistic charting system makes 
these resources less than useful unless you stick to eyepiece-sized or slightly 
larger areas. For example, if you select a 10 degree field and have the Hubble 
GSC stars turned on, you’ll get 10 degrees of sky, but in the form of a completely 
whited-out screen. AstroPlanner’s chart engine, you see, won’t automatically 
adjust stellar magnitudes when you zoom out. It will warn you that you’re about to 
display LOTS of stars, however, giving you the chance to change your mind or 
turn off the GSC (or whatever).  
 
Charting is also a trifle slow. Change anything, and you’ll get a five second 
countdown before your chart/changes appear. If you’ve got a large star catalog 
like the GSC enabled, there’ll be a further short delay as its stars are plotted. I 
was never annoyed by this time lag, but I was often aware of it. 



 
While the basic Field of View system is a little minimalist, it does do a lot of cool 
“extra” things. Like, for example, superimposing an astrometric reticle; one 
similar in layout to the complex reticle on Celestron’s and Meade’s astrometric 
eyepieces. Numerous other reticles are also available, including the Telrad and 
Rigel Quickfinder. There are some interactive features too. You can add charted 
objects to your plan with a click, center objects in the Field of View with a click, 
and send your goto telescope to these objects with a click. 
 

 
 
Yes, AstroPlanner’s  charts are somewhat rudimentary, but are just fine if, again, 
you’re content to limit yourself to eyepiece-sized fields. How easy is it to tailor 
these fields for your specific eyepieces and scope? Very easy. Based on the 
information you entered into Resources, you’ll have pull downs that contain the 
data from your equipment inventory. Setting the field size to reflect your current 
scope/eyepiece takes no more than a couple of seconds.  
 
No, charting is probably not AstroPlanner’s  strong point. But there are a couple of 
things to keep in mind in this regard. If you’re mainly a goto user (and many of 
AP’s fans seem, like me, to be heavily into goto), you’ll rarely need detailed 
large-scale charts. Something four or five degrees wide at max, showing you 
what else interesting is in the neighborhood, is usually all you need, and AP’s 
charts are more than able to do that. Need more-better-gooder? Remember, you 



can set up Cartes du Ciel to work with AP. The charts CdC generates are easily 
as detailed and useful as those from any other astronomy program. 
 
What’s left? One tab: Sky. This one is easy enough to figger out. Clicking on it 
brings up a round all-sky chart tailored for the selected location and current 
program date and time. It will show some of the things you’d expect of a good 
planisphere—bright stars with names and constellation figures. It won’t show 
some of the things you would expect of a planisphere—like the bright Messiers. 
In return it will show some things your planisphere can’t or doesn’t—the planets 
and meteor shower radiants.  
 

 
 
“Sky” can also be set to display goto scope alignment stars. These are mostly of 
the Meade variety, since this part of the program is where Best Pair II resides, 
but, frankly, Meade and Celestron use (mostly) the same stars anyway. If you’ve 
got a Meade (or maybe even Celestron) scope and are using an alignment mode 
that requires you to pick stars, you can use Best Pair. Push the “Find Best Pair,” 
button and the program will list the most effective pairs of alignment in order of 
decreasing goodness. 
 
So is that it? Is that all AP does? Not hardly. How about scripting? Wut’s they-at? 
The ability to write small computer program-like sets of instructions that 
AstroPlanner will execute. What good is that? It makes the program potentially 
able to do just about anything. I, for example, mentioned to Paul that I wished 



there were a way to have the program find pairs of deep sky objects located 
close to each other. “No problem,” he said, and soon sent me a little script that 
did just that, and which also allowed me to select numerous parameters for my 
close-pairs searches. 
 
Yeah, AP does one heck of a lot. This may, in fact, be the most feature heavy 
program we’ve seen yet, at least in the planning/logging genre. In every area, 
I’ve just skimmed the surface—remember that 300 page user’s manual. I have hit 
the high points, and I think I’ve given you enough info to get you started using 
this fine program productively. Oh, I’m not just being nice when I say “fine,” 
either. As I hinted earlier, I find AP is now 50% of the astronomy software I use 
day in and day out (the other 50% being TheSky 6 Professional). It’s that good.  
 

 
 
Skeptical? This is one you can afford to try. Actually, you can try it before you 
pay anything. Just go to http://www.ilangainc.com/AstroPlanner/index.html and 
proceed to the download area. You’ll find a fully operational version you can use 
FOREVER without paying one red cent. It’s limited in the catalog area (Messier, 
NGC, and Yale Bright Star only), and there are a few fancy features you won’t be 
able to use, but the free version will definitely allow you to try AP on for size. 
Frankly, most people don’t even bother with “free AP.” The full version on CD is 
only 40 bucks, and the downloadable AP is an astonishing 25 (it’s identical to the 
CD version, but you have to do all the downloading, including all those big 
catalogs).  
 
How can you lose? You can’t, good buddy, you can’t. 
 
 



 
 
 
 
 
 
 


